
ACCORDION PANEL MAGIC 3  (APM3) 

 

APM3 is a Dreamweaver extension that allows you to add accordion widgets to an existing page in just a few 

seconds—with markup and CSS that is clean, efficient, and easy to understand. You can add multiple widgets to a 

page and each one can contain as many content panels as you need. Content panels can contain text, images, 

links, forms, or tables and are editable in Dreamweaver Design View at all times. Each widget can have its own 

styling or widgets can share the same styles—the choice is yours. 

We hope you enjoy using this product as much as we did making it. 

Al Sparber & Gerry Jacobsen, PVII 
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4 Install the extension 

INSTALL THE EXTENSION  

Look for the extension installer file p7_APM3_323.mxp or p7_APM3_323_upg.mxp in the root of the zip archive 

you downloaded. Double-click the file to install the extension. Dreamweaver's Extension Manager will open and 

you will be prompted to complete the installation. Upon completion, restart Dreamweaver. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have a file association issue. To remedy the 

problem locate the installer file from inside a Finder window and double-click it. 

WORK IN A DEFINED DREAMWEAVER SITE  

Before you begin, make sure you are working inside a defined Dreamweaver web site. This is necessary so that 

Dreamweaver knows how to link required assets. If you are new to Dreamweaver or need to learn how to define a 

web site, follow these simple steps: 

Choose Site > New Site 

SPECI FY  LO CAL SIT E LO CATION   

The Site category of the Site Setup dialog box is the only one you need to fill out to begin working on your 

Dreamweaver site. This category lets you specify the local folder where you’ll store all of your site files. When 

you’re ready, you can fill out the other categories in the Site Setup dialog box, including the Servers category, 

where you can specify a remote folder on your remote server.  

S I T E  NA M E   

The name that appears in the Files panel and in the Manage Sites dialog box; it does not appear in the browser.  

L O C A L  S I T E  F O L D E R   

This is the folder on your local disk where you store site files, templates, and library items. Create a folder on your 

hard disk or click the folder icon to browse to the folder. When Dreamweaver resolves site root-relative links, it 

does so relative to this folder. 
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5 Inserting a New APM3 Widget 

INSERTING A NEW APM3  WIDGET  

Widgets can be inserted anywhere on your page—even into the content panel of an existing APM3 widget. Once 

you have established your insertion point, click the APM3 icon  to open the interface. Alternatively, you can 

choose Insert > Studio VII > Accordion Panel Magic 3 by PVII.  

The widget will adapt to the width of the element in which it was inserted—whether that width is fixed or flexible. 

In the absence of a containing element, the widget will stretch the full available width of your browser window. 

You can insert as many individual widgets as you like on a page. Each one can be configured independently to set 

different options and features. Multiple APM3 widgets on a single page can share the same style theme or be set 

to separate themes. Each widget can contain any type of content. Content panels are directly editable in 

Dreamweaver Design View using normal Dreamweaver editing techniques. 

-Establish the insertion point for your new APM3 widget by clicking in the area of the page where you would like it 

to be created.  

-Click the APM3 icon  in the PVI I  Section of Dreamweaver's Insert Bar or choose Insert > Studio VII > Accordion 

Panel Magic 3 by PVII. 

C L A S S I C  D R E A M W E A V E R  I N S E R T  BA R  

 

DR E A M W E A V E R  IN S E R T  P A N E L  
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6 Inserting a New APM3 Widget 

The APM3 user interface will open in the Create New Accordion Panel Magic 3 mode.  

 

Configure your widget, set your options, and then click OK to build the widget at your insertion point. 

You can create as many as you like on your page. 

Tip: When you insert an APM3 widget, all content will be visible and fully expanded in Dreamweaver to make adding and editing content a 

simple task. The widget's functionality can be tested by previewing in a browser. 
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7 Inserting a New APM3 Widget 

AS S ET  FO LDERS  

When you create a widget, the system creates an assets folder named p7ap3 at the same level as the page that 

contains your widget. This folder will contain a JavaScript file, relevant CSS files, as well as an img sub-folder that 

contains background images used by the CSS. 

If any of your content panels have been formatted with multi-columns, the system will also create a p7ehc folder 

to house the Equal Height Columns script, which ensures that your columns are always equal in height. 

 

When you publish your site, make sure you upload the entire p7ap3 folder and, if present, the entire p7ehc folder.  
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8 Modifying an Existing APM3 Widget 

MODIFYING AN EXISTING APM3  WIDGET  

You can modify any of the existing widgets on your page at any time. 

-Click inside the widget that you wish to modify. 

-Click the APM3 icon  in the PVI I  Section of Dreamweaver's Insert Bar or Insert Panel—or choose Modify > 

Studio VII > Modify Accordion Panel Magic 3 by PVII 

Note: If you use a Macintosh computer, Apple bugs will sometimes cause the Modify menu to be inactive (grayed out). If this happens to you, 

use the icon to launch the interface. You can also launch the interface from the Insert menu. The system will open the interface in the 

appropriate mode whether you use the Insert Menu, Insert Panel/Bar or the Modify menu. 

S E L E C T  A C T I O N  D I A L O G  

The Select Action dialog box will be displayed—allowing you to choose to create a new nested widget at your 

insertion point inside an existing widget's panel, or to Modify the existing widget. 

 

Note: This dialog only appears when your insertion point is inside of an existing APM3 panel. If not, the main interface will open in Create 

mode. 
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9 Managing the User Interface Items 

The Accordion Panel Magic 3 User Interface will open in the Modify Existing Accordion Panel Magic 3 mode. 

 

Configure your panels and options and click OK. 

MANAGING THE USER INTERFACE ITEMS  
Let’s look at the individual options and settings available in the user interface. 

MODE  

Displays the current operational Mode for the user interface: either CR E A T E  or MO D I F Y . When in Modify mode, 

the id of the widget being modified will also be displayed. 
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10 Managing the User Interface Items 

PAN EL HEADIN GS  

This box displays the text for each panel trigger in the widget—one line for each panel or external link. Select the 

line you wish to act on. 

AD D  PA N E L  

Click the Add button to add a new content panel. A new line will be created with the default text "Heading Text". 

The new line will be created immediately after the currently selected line. 

DE L E T E  PA N E L  

Click the Delete button to remove the currently selected line. The content panel will be removed.  

UP   

The Up button will move the selected line in the PA N E LS  list up one row. Successive clicks will keep moving the line 

upward, one row per click, until the line is at the top of the list.  

DO W N  

The Down button will move the selected line in the PA N E L S  list down one row. Successive clicks will keep moving 

the line down, one row per click, until the line is at the bottom of the list.  

HEADIN G TEXT  

The Heading Text box displays the text of the currently selected line in the PA N E L  HE A D I N G S  list. The text can be 

edited at any time. TH E  B O X  CA N N O T  B E  LE F T  B LA N K .  

Note: If an image has been assigned, this box will be disabled (grayed out) and will instead contain the file name of the assigned image. 

Removing the Image Path will re-enable this box for editing. 

L I N K  O N L Y -NO  AS S O C I A T E D  C O N T E N T  PA N E L   

Check this box if you wish to have the selected Heading Text serve as a normal page link. There will be no 

associated content panel. If you set this option for an existing panel heading, its content panel will be removed. 

L INK PAT H /  BROW S E . . .   

The Link box is activated whenever the Link Only option is enabled. Enter the path to the linked page or use the 

Browse button to open a Windows or Mac B R O W S E  T O  F I L E  dialog. If no entry is made, the system will 

automatically supply a named anchor to the associated content panel. 
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11 Managing the User Interface Items 

TRI GGER  IMAGE /  BRO WS E . . .  

Note: The Image Path box is only used if you are using images for your headings. For text-based headings this box should be left empty.  

Enter the path to your image or use the Browse button to open a SE LE C T  IM A G E  SO U R C E  dialog box. You can 

change the image at any time by selecting the trigger item in the Panel Headings list and clicking the "Browse..." 

button. Valid image types are limited to the .G I F , . J P G , and .P N G  file types. 

The image you select must always be the default state image. The system will automatically handle image pre-

loading. Images for additional states (over, down, and overdown), depending on the Image Swap Option you 

select, must be stored in the same folder as your default image. The system will automatically find them. Default 

state image file names can be any valid name. You must, however, follow a naming convention for the additional 

state images. 

ALT TEXT  

Enter a description for the related image in the Alt Text box. If the image is a picture of hats, then HA T S  would be 

a good choice for the text to use. 

CONT EN T LAYO UT  

When adding a new panel you can choose a content format: 

 Default (Single-Column) 

 2 Columns 50/50 

 2 Column-Sidebar Left  

 2 Column-Sidebar Right 

 3 Column 33/33/33 

 3 Column-Wide Middle 

 4 Column 25/25/25/25 

Note: This option is available ONLY for newly created panels. It will unavailable (grayed out) for existing panels. If you want to change the 

format of an existing panel, create a new one below it. Then copy the content from the existing one into the new one. When you are done, 

open the interface again and delete the old panel. 
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12 Options 

OPTIONS  

These settings are applied to the current widget. Other widgets on the same page can have different options.  

TRI GGER  ACTI ON  

S H O W  O N E  PA N E L  A T  A  T I M E  

Select this option to automatically close any other open panels when a new panel is opened. This ensures that only 

one panel is displayed at a time. This option toggles open panels only within the same APM3 widget. Other widgets 

on the page will not be affected. 

AL W A Y S  K E E P  O N E  PA N E L  O P E N  

This setting will ensure that your Accordion Panel will never be completely closed. Successive clicks on the 

currently open panel's heading text will not close that panel. 

EN A B L E  MO U S E  O V E R  O P E N  AC T I O N  

Check this box to allow mouse over activation of the panel headings. The associated panel will open whenever the 

user moves his mouse over the panel heading. The click behavior to open or close the panel will still remain 

enabled (supporting keyboard and mobile device users). 

EN A B L E  MO U S E  O U T  C L O S E  AC T I O N  

Check this box if you wish to allow a close action when the user moves his mouse away from the Heading Text 

onto another area of the page. Mouse Out close action will also take place when the user moves his mouse out of 

the content panel. 
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13 Options 

RESPO NSIV E  

EN A B L E  RE S P O N S I V E  MO D E  

When you enable Responsive Mode, the APM3 system will display a toggle icon above it when viewed on a 

smartphone—or in a conventional browser window when its width is less than 700 pixels. The toggle icon permits 

users to completely hide the widget so that they can view more of the page content.  

S T A R T  W I T H  C L O S E D  TO O L B A R  

Set this option if you want the default state of your APM3 system, when viewed on a smartphone, to be closed. 

Users will be able to control the visibility of the system by clicking the toggle icon or text links. 

S H O W  TO G G L E  TE X T  

Enable this option to also show a text label, "Show Menu" or "Hide Menu" next to the toggle icon in the toolbar. 

The actual text content for these labels can be modified in the Smartphone Menu Media Query section of the 

APM3 style sheet. 

PAGE LO AD  

You can configure how APM3 sets up when the page first loads into the browser.  

O P E N  W I T H  AL L  PA N E L S  C L O S E D  

The Accordion Panel will start out with all panels closed. 

O P E N  A  S P E C I F I C  PA N E L   

You can select a specific panel to open when the Accordion Panel initializes. Selecting this option will activate the 

Panel Number box where you can enter the number of the panel you wish to be open on startup. 
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14 Options 

O P E N  A  RA N D O M  PA N E L  

Select this option if you wish to have the system randomly select a panel to open. Each time the page loads a 

random panel will be selected. 

O P E N  AL L  PA N E L S  

Select this option if you want all panels open when the page loads. 

O P E N  AL L  PA N E L S  TH E N  C L O S E  AL L  

This option will load the page with all panels open. After a brief delay, the panels will all glide closed. 

AUTO ROT AT E  

APM3 includes an automated panel rotator system that will display each panel in succession, starting with the 

currently active panel. The system also includes a Rotate Behavior that allows you to control the Rotator actions 

externally. 

AU T O  RO T A T E  PA N E L S  O N  S T A R T U P  

Check this box if you want to have the panel rotator start automatically when the page first loads. 

C Y C L E S  

The system will display all of the panels in succession once—or you can set it to loop any number of times. Enter 

the number of times you want the system to loop through the rotation. To have the Rotator loop indefinitely enter 

a very high number, such as 9999. 

DE L A Y  

This controls the amount of time each panel is displayed during the rotation, in milliseconds. The default is 5000ms 

(5 seconds). 
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15 Options 

CURR EN T MAR KIN G  

These settings control the operation of the included automatic Current Marking system. 

EN A B L E  C U R R E N T  MA R K I N G  

Check this box to enable automatic current marking (highlighting) of links in your APM3 widget. The system looks 

for links in the widget's panels that match the current page address. When a matching link is found, it's highlighted 

and the associated panel is set to be the currently active one. The system assigns a special style class named 

current_ mark to this link and also to its associated Trigger Link. This provides a visual "Y O U  A R E  H E R E "  indicator. 

O P E N  PA N E L  WH E N  MA R K E D  

Check this box if you wish to have the panel associated with the current-marked panel open automatically when 

the page loads. Uncheck this box if you wish to have the current-marked panel remain closed. 

IN C L U D E  URL  PA R A M E T E R S  I N  MA T C H  

This option controls whether the automatic current-marking feature will include any URL parameters in the page 

address when looking for a matching link in the widget. Check this box if you wish to have your URL parameters 

included in the match criteria. 
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16 Options 

IMAGE SW AP  OPTION S  

The system supports using images for any of the Trigger links and is designed to automatically handle pre-loading, 

swapping, maintaining states, and assigning a current-marker. This automation requires that you follow the image 

file name convention. The system supports up to 3 different image states. Select the Swap Option that you would 

like to use: 

 Single Image Only -Choose this option if you are using just a single image and do not want any swap 

actions. 

 Normal and Over - Choose this option if you are using two images: one normal image and one for the 

over (hover) state. The over image will also be used as the open (down) state and current-mark images. 

 Normal, Over and Open Images - Choose this option if you are using three images: one normal image, 

one for the over (hover) state, and one for the open (down) state. The open state image will be used for 

the current-marker images.  

Note: Be sure to choose the option carefully to match the number of image states you are using. The system will pre-load the various state 

images based on this selection. 

R O L L O V E R  OP E N  ST A T E  

This controls the swap action when the trigger link is in its open state. The system will swap to the over image if 

the trigger link is in the open state and you have a 3-state swap option set. Uncheck the box if you want to disable 

this swap action. 
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17 Options 

ANI MATION  

You can choose from 3 animation methods or animation can be turned off. 

AN I M A T I O N  L I S T  

 

DU R A T I O N  

This option allows you to control the animation speed. DU R A T I O N  defines the total amount of time that the 

animation will run, in milliseconds, regardless of a content panel's dimensions. The default 250  is fine in most 

cases. Lower the DU R A T I O N  setting and the animation will be faster. Raise the setting to make the animation 

slower. 

STY LE THEME  

APM3 comes with a variety of pre-defined CSS style themes. Choose a theme that best approximates the look you 

desire. You can later make edits to the style sheet to fully customize your widgets. You can change to a different 

style theme at any time without affecting the content inside the widget.  

 

A preview of the selected Style Theme is displayed to the right of the Style Theme select list. This Preview will 

change whenever you select a different Style Theme. 
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18 Options 

CO MMAN D BUTT ONS  

The following command buttons are available. 

OK 

When you are done, click the OK button to build the widget. You can then preview in a browser to test your 

widget. 

C A N C E L  

Click the Cancel button to completely abort the current operation. This will close the interface and no changes will 

be made to your page. 

HE L P  

Click the Help button to open the relevant help page in your browser. The help page can remain open while you 

continue working with the Accordion Panel Magic 3 interface. 

  



 

 19  

 

19 Converting Previous Versions of APM to APM3 

CONVERTING PREVIOUS VERSIONS OF APM  TO APM3 

The APM3 system can convert an existing Accordion Panel Magic 1 widget to an APM3 widget. Conversion is as 

easy as clicking inside the existing APM1  or APM2  widget and opening the APM3 interface. 

Place your cursor inside the existing APM1 or APM2 widget and open the APM3 interface. The system will detect 

that your insertion point is inside an APM1 or APM2 widget and the CO N V E R T  F R O M  AC CO R D I O N  PA N E L  1  ( O R  

2)  interface will open.  

 

C H O O S E  A N  AC T I O N  

1. Click the Convert to APM3 button to launch the CO N V E R S I O N  process.  

The system will open the APM3 MO D I F Y  interface populated with the existing Trigger and Panel data from your 

old widget. Existing Style Theme and Animation options will be reflected in the interface. Make any changes and 

set any new options as desired, then click OK to finish the conversion process. The HTML markup for the original 

widget will be replaced with APM3 markup. The original S T Y LE  S H E E T  link will be removed and a new APM3 style 

sheet will be linked in its place. The old S CR I P T  link will be replaced by a link to the APM3 script. 

2. Click the Create a new APM3 Panel inside APM1 (or 2) button to launch APM3 in Create mode.  

The system will create a new APM3 widget at the current insertion point inside the existing widget, which will not 

be altered. 

Tip: When you convert an older widget, its original style theme will be used in default APM3 form. If your old widget's theme was customized, 

you will need to edit the new APM3 theme's style sheet. In most cases, this should be a fairly easy task of changing a few background-color and 

color property values. If your CSS skills are not up to the task, contact us or post on our forum and we will be happy to help. 

  

http://www.pviiforums.com/
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20 Removing an APM3 Widget 

REMOVING AN APM3  WIDGET  

The APM3 system includes a Remove command that allows you to quickly and thoroughly remove an existing 

widget from your page. Using this command will ensure that there are no code corruptions or remnants left on 

your page, which can easily happen if you attempt to remove the widget manually. 

OP EN  T HE REMOV E I NT ER FACE  

Open a page that contains one or more APM3 widgets. Choose Commands > Studio VII > Remove Accordion Panel 

Magic 3 to open the RE M O V E  interface.  

Note: The Remove option will be unavailable (grayed out) if there is no APM3 widget on the page. Some Mac systems have compatibility 

problems with Dreamweaver. If the Remove command is grayed out and inaccessible, download and install this command: Return False Fix. 

After installing it, restart Dreamweaver and your menus will be accessible. 

 

The interface will provide a listing of all the APM3 widgets on your page. The list will display the root ID for each 

widget. From the listing, select the widget that you wish to remove. You can remove one widget at a time. 

Tip: If you are unsure about which widget relates to which ID, click the Cancel button and switch to Code View. In Code View, locate all IDs that 

begin with p7AP3. The opening DIV tag for an APM3 widget looks like this: <div id="p7AP3_1" class="p7AP3-01 p7AP3"> 

WH A T  W I L L  B E  RE M O V E D   

The system will remove the HTML markup for the selected widget, along with the markup for any widgets nested 

inside of it. The system will also remove the link to the relevant CSS files—I F  N O  O T H E R  W I D G E T  O N  T H E  P A G E  I S  

U S I N G  T H O S E  F I LE S . If there are no remaining APM3 widgets on your page, the system will also remove the link to 

the APM3 JavaScript file. 

WH A T  W I L L  NO T  B E  RE M O V E D  

The system will not remove the p7AP3 assets folder, which may be in use by widgets on other pages. This also 

ensures that you will not lose any customized CSS files or images. 

  

http://www.projectseven.com/go/returnfalsefix
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21 APM3 Image File Naming Convention 

APM3  IMAGE FILE NAMING CONVENTION  

APM3 supports the use of image-based trigger links with preloading, swapping, multiple state management and 

current-marking automatically handled. The system supports up to 3 different image states: 

 Normal - the base image 

 Over - appears on hover 

 Down - appears when the related panel is open 

The system automatically loads the appropriate image according to the Image Swap option selected in the User 

Interface. When you choose an image in the APM3 interface, you only choose the Normal (base) image. The 

system will look at your SW AP  OP T I O N S  and, if additional images are required, they will be located automatically 

in the folder that contains your NO R M A L  state image. This automation requires that you follow an image file 

naming convention. Your Normal image file name can be anything you like—but you must follow a naming 

convention for the Over and Down state images. If your NO R M A L  image is named myButton.gif, the following 

conventions must be used: 

 The Over image that displays on hover would be named: myButton_over.gif  

 The Down image that displays when its associated panel is open would be named: myButton_down.gif 

AC C O R D I O N  PA N E L  MA G I C  3  DE F A U L T  NA M I N G  C O N V E N T I O N :  

 Normal Image: myButton.gif 

 Over Image: myButton_over.gif 

 Down Image: myButton_down.gif  
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22 External Linking and Bookmark Support 

EXTERNAL LINKING AND BOOKMARK SUPPORT  

An opener detection system is included that allows you to set up links with special parameters that will load a page 

and also trigger a specific panel in an APM3 widget on that page. The opener will look for the APM3 widget 

number, an underscore, and the APM3 content panel number. There are 2 methods available: 

 Anchor Method: The system will look for "#ap3" plus a panel reference after the anchor. The anchor 

index.htm#ap31_4 will trigger panel 4 in the first APM3 Widget on the page.  

 URL Parameter Method: The system will look for "ap3=" in the URL parameter. The URL parameter 

index.htm?ap3=2_4 will trigger panel 4 in the second APM3 Widget on the page. You can then give out 

the link so people can go directly to your specific content panel. 

Note: This feature is meant to be used on links to your page from external locations—not on links that are in your page. If you want to add links 

on your page that control the panels, you would use the Control Behaviors described below. 
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23 CSS Editing 

CSS  EDITING  

APM3 themes utilize advanced and modern CSS, resulting in beautiful designs that are remarkably easy to 

customize—without having to worry about editing complex background images. 

CUSTO MI ZIN G TRIGGER  L INK  COLO R S AN D EFFECT S  

The majority of customizations will involve changing the colors and/or effects assigned to the trigger links—the 

headings that are used to operate your panels. Let's look at the trigger link style rules for the Cayenne theme: 

The actual rules in your style sheet have more properties. We will only list those which you are likely to want to 

edit: 

.p7AP3trig.p7ap3-theme-05 a { 

padding: 10px 20px; 

color: #000; 

background-color: #C30; 

font-weight: normal; 

background-image: url(img/p7ap3_east_black.gif); 

border-bottom: 1px solid #000; 

border-top: 1px solid #FB3F00; 

font-variant: small-caps; 

box-shadow: inset 0px 20px 20px rgba(255,255,255,.1); 

-webkit-transition: all linear 0.15s 0.1s; 

transition: all linear 0.15s 0.1s; 

} 

The above rule is the default state of your trigger links. 

Padding is comprised of 2 values. The first value (10px) controls the height of the trigger link. The second value 

controls the amount of whitespace to the left and right of the link text. 

Color controls the text color. 

Background-color set the background color for each trigger link. 

Font-weight can be either N O R M A L  or B O LD . 

Background-image determines the icon to the left of the trigger link text. Your p7ap3/img folder contains black, 

gray, and white versions of each arrow. To change the arrow above to a white one, simply set the image name to 

p7ap3_east_white.gif 
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Border-bottom and border-top sets a border below and above each link. If you change the background-color, you 

probably want to change the border-colors to suit. 

Font-Variant sets text to small caps. If you would like your text to appear in normal case-format, simply delete this 

property. 

Box-shadow is inset, which creates a gradient-like effect. Edit the x-axis, y-axis and blur radius (0px 20px 20px) to 

change the effect. Do not change inset or the rgba color value. Using an rgba color means you can simply change 

the background-color and your effect will continue to look good. 

Transition creates the basis for a CSS3 animation. The all value means that when a user hovers over the trigger, 

the browser will take all the properties common to the default and hover states and animate the difference using, 

in this case, a linear transition that takes .15  S E C O N D S  to complete, with a .1  S E CO N D  D E LA Y . Firefox and IE10 

support the standard property name, while Chrome and Safari (at this writing) require the -webkit- prefix. The 

duplicate prefixed property is always listed ahead of the standard version. 

.p7AP3trig.p7ap3-theme-05 .p7AP3_ext, .p7AP3trig.p7ap3-theme-05 .p7AP3_ext.p7AP3trig_down { 

background-image: url(img/p7ap3_page_black.gif); 

color: #000; 

background-color: #C30; 

} 

The above rule applies to trigger links that have been set to external links using the Link Only- No Associated 

Content Panel option in the interface. 

.p7AP3_ext:hover { 

background-image: url(img/p7ap3_page_white.gif) !important; 

} 

The above rule sets a special page icon for external links on hover. Just like the arrow icons, the p7ap3/img folder 

contains black, gray, and white versions you can use as needed. 

.p7AP3trig.p7ap3-theme-05 a:hover { 

color: #FFF; 

background-color: #222; 

border-color: #222; 

background-image: url(img/p7ap3_south_white.gif); 

} 

The above rule is the hover state for your trigger links. 
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.p7AP3trig.p7ap3-theme-05 .p7AP3trig_down, .p7AP3trig.p7ap3-theme-05 .p7AP3trig_down:hover { 

background-image: url(img/p7ap3_south_gray.gif); 

background-color: #222; 

color: #CCC; 

border-color: #222; 

} 

The above rule is the down state for your trigger links—which occurs when a trigger's associated panel is open. The 

default and hover states are combined into a single rule. 

PROGR ES SIV E EN HAN CEME NT  

Accordion Panel Magic 3 employs the concept of progressive enhancement. We start with well-formed code that 

displays all content in all devices. Then we use CSS3 for rounded corners, shadows, and animated transitions. We 

also use CSS3 media queries to reflow multi-column content inside your panels for optimal rendering on 

smartphones. These effects are deployed in ways that enhance modern browsers and devices while assuring an 

attractive and accessible presentation in older browsers. 
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APM3  CONTROL BEHAVIORS  

APM3 comes with 3 very handy behaviors to control APM3 functions that you can assign to ordinary links on your 

page. The links can be anywhere on your page—even inside an APM3 content panel. The Behaviors are: 

1. Trigger Panel 

2. Rotate 

3. Open/Close All 

CR EATIN G A N EW  APM3  BEHAVIOR  

1. Select (click) a text link or image to act as the behavior trigger.  

2. Open your Behaviors panel (Shift + F4)  

3. Click the plus sign (+) on the Behaviors panel.  

4. Choose Studio VII > Accordion Panel Magic 3 > then...  

5. Select one of the 3 available Behaviors  

MODIFYIN G AN EXIS TI NG BEHAVIOR  

1. Select the element that contains an existing Accordion Panel 3 behavior.  

2. Double-click the behavior in the Behaviors panel to open the interface.  

3. Edit your options.  
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THE TRI GGER  PAN EL INTER FACE  

The Accordion Panel Magic 3 -Panel Trigger interface allows you to select the panel to trigger. 

 

AC C O R D I O N  PA N E L  TR I G G E R  

The interface contains a listing of all of the Panel Triggers in all of the APM3 widgets on the page. Select the PA N E L  

TR I G G E R  you want to affect. The Panel Triggers are listed by ID. The ID begins with p7AP3t followed by the widget 

number, an underscore, and then the content panel number. For example, p7AP3t1_1 would be the first PA N E L  

TR I G G E R  in the first APM3 widget on the page, while p7AP3t3_2 would be the second P A N E L  TR I G G E R  in the third 

APM3 widget on the page. 

Select the Action you want to apply: 

OP E N  PA N E L  

This will open the selected panel. If the panel is already open then it will remain open.  

C L O S E  PA N E L  

This will close the selected panel. If the panel is already closed then it will remain closed.  

TR I G G E R  PA N E L  

This will emulate a user mouse click on the Panel Trigger in one of two ways:  

1. If the Panel Heading has an associated content panel then that panel will become active. 

2. If the Panel Heading does not have an associated content panel (Link Only option), then the hyperlink 

assigned to the Panel heading will be executed. 

Note: Any Trigger Option options set for this widget will also apply. For example, if "Always Keep One Panel Open" is set, and your behavior is 

set to act on a panel that happens to be open, clicking the link will not close that panel. 
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THE RO TAT E IN TER FACE  

The Rotator interface allows you to select the Rotation options. 

 

AC C O R D I O N  PA N E L  MA G I C  3 

The interface contains a listing of all of the APM3 widgets on the page. The widgets are listed by ID, using a naming 

convention that begins with p7AP3_ followed by the widget number. SE LE CT  T H E  W I D G E T  T O  A C T  O N . 

Select the Action you want to apply:  

PA U S E  

This will stop or pause the Rotator and the panel that is currently displayed will remain displayed.  

PL A Y  O R  R E S U M E  

This will start a Rotator cycle. Each panel will be displayed successively and rotation will continue for the number 

of cycles specified. 

S E T  A  NU M B E R  O F  C Y C L E S  

This controls the number of times the system will repeat each rotation. All panels are displayed in one rotation. 

The system will replay the rotation again for the number of times specified in this option. 

S T A R T  W I T H  PA N E L  

You can select which panel the rotation will start with. 
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C U R R E N T  A C T I V E  PA N E L  

Check this box if you want the rotation to start with the panel that is currently open. This is the default and is also 

the option to use if you are creating a "Resume" behavior. 

PA N E L  N U M B E R  

Enter the number of the panel you want the rotation to start with. You must also uncheck the CU R R E N T  AC T I V E  

PA N E L  box to enable this feature. 

THE OP EN/CLOS E ALL INT ERFACE  

The Accordion Panel Magic 3 -Open/Close All interface allows you to select the following options. 

 

AC C O R D I O N  PA N E L MA G I C  3 

This list contains the IDs for all of the individual APM3 widgets on the page, as well as an All on this Page option. 

The APM3 widgets are listed by ID, which follows a naming convention beginning with p7AP3_ followed by the 

widget number.  

Select the Action you want to apply:  

OP E N  

This will open all of the panels in the selected widget(s). 

C L O S E  

This will close all of the panels in the selected widget(s). 

Note: If the Show Only One Panel at a Time or Always Keep One Panel Open options are enabled, the action will override them and open or 

close all of the panels. 
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SUPPORT AND CONTACT INFO  

PVII quality does not end with your purchase - it continues with the best customer support in the business. 

PVII  KNOW LEDGE BAS E  

The PVII Knowledge Base is an online PVII application allowing you to access dozens of Tech Notes, tips, and 

techniques relating to our products, as well as to general web development issues. 

Open the Knowledge Base 

NEWS GRO UP  FO RU M CO MMUNITI ES  

The Project VII Newsgroup community is our primary support vehicle and is available 24 hours a day. Choose from 

the following newsgroups:  

1. The PVII Webdev Newsgroup 

2. The PVII Dreamweaver Newsgroup 

3. The PVII Fireworks Newsgroup 

4. The PVII CSS Newsgroup 

Note: If you have trouble linking directly to news servers, use your default newsreader's program options to set up a new account and point it 

at the following server: 

forums.projectseven.com 

Setting up a new newsgroup account in Outlook Express 

Setting up a new newsgroup account in Mozilla Thunderbird  

Setting up a new newsgroup account in Entourage  

If you have another newsgroup-capable program that you are using, please see its documentation to learn how to 

add a new newsgroup account. 

Note: PVII newsgroups are private and have nothing to do with usenet feeds that may be provided by your ISP. That is, you will not find our 

newsgroups in a list of newsgroups distributed by your internet service provider. You must set up our news server as a new account.  

  

http://www.projectseven.com/support/questions.asp
http://www.projectseven.com/support/oe.htm
http://www.projectseven.com/support/tbird.htm
http://www.projectseven.com/support/entourage.htm
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RSS  NEWS  FEEDS  

Keep up with the latest news the minute it's released by subscribing to our RSS news feed. If you are not sure how 

to subscribe, please check this page: 

PVII RSS Info 

BEFO R E YO U CONT ACT  US  

Before making a support inquiry, please be certain to have read the documentation that came with your product. 

Please include your Dreamweaver version, as well as your computer operating system type in all support 

correspondence. 

E-Mail: 

support@projectseven.com 

Phones: 

330-650-3675 

336-374-4611 

Phone hours are 9:00am - 5:00pm Eastern Time U.S. 

SNAI L MAI L  

Project Seven Development 

339 Cristi Lane  

Dobson, NC 27017 

  

http://www.projectseven.com/xml/index.htm
mailto:support@projectseven.com

	Accordion Panel Magic 3 (APM3)
	Install the extension
	Work in a defined Dreamweaver site
	Specify local site location
	Site Name
	Local Site Folder


	Inserting a New APM3 Widget
	Classic Dreamweaver Insert Bar
	Dreamweaver Insert Panel
	Asset Folders

	Modifying an Existing APM3 Widget
	Select Action Dialog

	Managing the User Interface Items
	Mode
	Panel Headings
	Add Panel
	Delete Panel
	Up
	Down

	Heading Text
	Link Only-No Associated Content Panel

	Link Path / Browse...
	Trigger Image / Browse...
	Alt Text
	Content Layout

	Options
	Trigger Action
	Show One Panel at a Time
	Always Keep One Panel Open
	Enable Mouse Over Open Action
	Enable Mouse Out Close Action

	Responsive
	Enable Responsive Mode
	Start With Closed Toolbar
	Show Toggle Text

	Page Load
	Open With All Panels Closed
	Open a Specific Panel
	Open a Random Panel
	Open All Panels
	Open All Panels Then Close All

	Auto Rotate
	Auto Rotate Panels on Startup
	Cycles
	Delay

	Current Marking
	Enable Current Marking
	Open Panel When Marked
	Include URL Parameters in Match

	Image Swap Options
	Rollover Open State

	Animation
	Animation List
	Duration


	Style Theme
	Command Buttons
	OK
	Cancel
	Help


	Converting Previous Versions of APM to APM3
	Choose an Action

	Removing an APM3 Widget
	Open the Remove interface
	What will be Removed
	What will Not be Removed


	APM3 Image File Naming Convention
	Accordion Panel Magic 3 Default Naming Convention:

	External Linking and Bookmark Support
	CSS Editing
	Customizing Trigger Link Colors and Effects
	Progressive enhancement

	APM3 Control Behaviors
	Creating a new APM3 behavior
	Modifying an Existing behavior
	The Trigger Panel Interface
	Accordion Panel Trigger
	Open Panel
	Close Panel
	Trigger Panel


	The Rotate Interface
	Accordion Panel Magic 3
	Pause
	Play or Resume

	Set a Number of Cycles
	Start With Panel
	Current Active Panel
	Panel Number


	The Open/Close All Interface
	Accordion PanelMagic 3
	Open
	Close



	Support and Contact info
	PVII Knowledge Base
	Newsgroup forum communities
	RSS News Feeds
	Before you Contact us
	Snail mail



